


Help for Lingea Lexicon 2000

What is displayed in the Lexicon window ?
Toolbar just below the menu 
Result of the inquiry top left window part 
List of references bottom left window part 
Translations of the entry right window part 
Status bar bottom window part

Memorizing bar in vocabulary memorizing mode 
Practicing bar in vocabulary practicing mode

Commands
File
Edit
Entry
Help

Information
About about the author of the program



Commands of the File menu
The File menu includes following commands:

English selects the English-Czech and Czech-English dictionary. 
German selects the German-Czech and Czech-German dictionary. 
Settings changes the order and selection of active dictionaries. 
Exit ends the Lingea Lexicon program. 



Commands of the Edit menu
The Edit menu includes following commands:

Copy copies a selected word or text to the clipboard. 
Paste pastes the text from the clipboard to the input bar and finds a 

relevant entry. 
User 
dictionary

allows to add or change user's own words or remarks to the 
existing headword. 

User topics allows to add or change user's own topics - thematic word 
groups. 

Font allows to change the font. 
Options allows to change the appearance of the application, displayed 

information and others. 



Commands of the Entry menu
The menu Entry includes following commands:

Find finds an entry in the dictionary. 
Memorize starts the memorizing or practicing modes with either included 

topics or user's own thematic word groups. 
Morphology displays morphological word forms in a well-ordered table. 
Pronounce plays recorded pronunciation of a word (only if the sound card is

available). 
Compare opens the dialog box for comparing the original pronunciation 

with the user recording. 
Back moves to the previous headword of the history list. 
Forward moves to the next headword of the history list. 
Previous moves to the alphabetically previous headword. 
Next moves to the alphabetically next headword. 



Commands of the Help menu
The menu Help includes following commands:

Topics displays the Help file. 
About displays the program version and information about the 

copyright holder. 



Settings
Use this command if you bought more dictionaries for one language and want to change the 
order of displaying the dictionaries or exclude displaying some of them. You can change the 
order both of supplemented and your own dictionaries that can be put even on the first 
place of the display list.

After pressing the command key a dialog box Dictionary configuration will appear.



Dialog box for setting dictionary groups
If you bought e.g. an English advanced dictionary and a German student's one, the English 
and Germangroups are automatically set. You can see them in the top part of the dialog 
box.

You can add another group, rename or delete an existing dictionary group, or change 
dictionary order of the source and target languages. Buttons have following meanings:

New 
After pressing this button you can add a new group into the list. The cursor will be moved
onto the list of entries, program will create a new item called "New group" and highlights 
the edited text. After you changed it finish editing by pressing the Enter key. Now you 
can adjust the source and target languages and change the dictionary order. You can also
insert a new entry by pressing the Ins key in the group list. 

Rename 
You can edit a dictionary group name by this command in case you need to change it. 
Clicking twice on the chosen name will just do the same. 

Delete 
By pressing this button you can delete an existing group from the list. You can delete an 
entry by pressing the Del key in the entry list as well. 

Source 
By pressing this button you select the source language of bilingual dictionaries, e.g. 
English. 

Target 
By pressing this button you select the target language of bilingual dictionaries, e.g. 
Czech. 

Dictionaries 
You can change the current dictionary order in the dialog Dictionary selection and order. 

OK 
By pressing this button you can terminate the editing of the dictionary groups and store 
the changes. 

Cancel 
By pressing this button you can terminate the editing of the dictionary groups without 
storing any changes. 



Dictionary selection and order
In this dialog box you can select the dictionaries and change their order.

The dictionaries that will be searched through are listed left, all other dictionaries for the 
chosen language combination are placed in the right list. Dictionary order of the left list can 
be changed by pressing the Up a Down keys, dictionary order of the right list is not 
important.

You can move dictionaries from left to right list and vice versa by the < a > buttons.



Exit (menu File)
Use this command to end the program.

All parameters set in the dialog boxes Settings, Options, Find or Memorize and test, as well 
as the position and the size of the program window and search history will be saved. The 
Lexicon will automatically restart in the same state as before. 

Abbreviations
Key: ALT+F4



Copy (menu Edit)
Use this command to copy a selected translation from the Lexicon    to another application, 
e.g. into a word processor. If you selecte no word from the offered translations with the left 
mouse button, the command is not performed.

You will replace the previous content of the clipboard by copying another text into it. 

Abbreviations
Key: CTRL+C



Paste (menu Edit)
You will use this command in case that you have inserted a text from another application, 
e.g. from a word processor, into the clipboard and you want to find its translation now. In this
way you can carry over both component words and word groups. In the latter case the 
Lexicon dictionary will display translation of the first word immediately and the other ones 
will be put into the list in the top window of the navigation bar. Then you can simply move 
from one translation of component words of the whole group to another through the mouse 
button or the arrow keys. 

Abbreviations
Key: CTRL+V



User dictionary (menu Edit)
You will use the command if you want to insert your own headword or to add another 
translation to an existing headword. The Lexicon dictionary can save such additions in a 
special file that can be edited in any text editor (even in the Notepad). Additional notes are 
displayed under a separate icon. Additions can be anytime modified, added, or completely 
removed.

The command will show the dialog box User dictionary. 

Abbreviations
Key: CTRL+D



Dialog box of the User dictionary
The dialog box includes two basic items:

· word list in the user's own dictionary 
· edit field for the user's own translations and notes 

It is possible to use several special marks in the translation field to have nearly the same 
appearance of the added entry as in the supplemented Lexicon dictionaries, where 
translations, examples, and additions are distinguished by colors or fonts. For instance for 
the user entry run, it is possible to set down 
=bìžet, utíkat (%spìšnì, rychle) 
=kandidovat (%na funkci) 
?run for = kandidatura (%na co) 
Just try it and you will see.

The added words are sorted except for the newly added entries that are put at the end of 
the list for better orientation. After restarting the Lexicon, they are sorted automatically.

New 
Press this button to add a new entry. The cursor is moved to the entry list, new item 
"New entry" is created and it is selected for editing. After changing it press the Enter key 
to finish the editing. When you press the Enter once more you the cursor will be moved 
to the editing field. You can insert a new item by pressing the Ins key in the entry list, as 
well. 

Rename 
Through this command you can start editing of an entry if you need to change it. Clicking
twice on the chosen word is sufficient, too - editing will start as well. 

Delete 
Through this command you can delete the current entry of the list. The Lexicon program 
asks your confirmation. After you have confirmed it the whole entry you have inserted 
before will be deleted. It is also possible to delete an entry by pressing the Del key in the
entry list. 

OK 
Terminates editing of your own additions and saves all changes. 

Cancel 
Through this command you will end editing of all the additions in the dictionary without 
saving the changes you have made. If you made some changes in the dictionary the 
Lexicon application will ask you to confirm it. 



User topics (menu Edit)
Use this command to create your own thematic word groups or to    change or delete the 
thematic groups created before. You can edit the thematic groups created either in a source 
language (English or German) or in target language (Czech) according to the current 
direction of translation (from source / to target language). The Lexicon application saves the 
thematic word groups added in this way into a separate file that can be    edited separately.    
Once created thematic word groups can be anytime reedited, extended, or completely 
removed.

The command will display the dialog box User topics. 

Abbreviations
Key: CTRL+E



Dialog User topics
The dialog box includes two basic items: 
· list of your own thematic word groups 
· editing field for headword list in a group 

The topic list is not sorted except for the newly added entries that are put at the end of the 
list for better orientation. After restarting the Lexicon dictionary, they are automatically 
sorted.

OK 
Ends the editing of your own thematic groups and saves the changes. 

New 
After pressing this button you can create new thematic groups. The cursor moves to the 
topic list, creates a new item "New topics" and highlights the edited text. After changing 
it press the Enter key to finish the editing. When you press the Enter once more the 
cursor will be moved to the editing field. You can insert a new topic by pressing the Ins 
key in the topic list, as well. 

Rename 
Through this command you can start editing of a topic name if you need to change it. 
Clicking twice on the chosen word will just do the same. 

Delete 
Through this command you can delete the whole selected thematic word group in the 
list. The Lexicon application asks you to confirm it. After confirming it the program will 
delete the whole thematic group you have inserted before. It is also possible to delete it 
by pressing the Del key in the topic list. 

Cancel 
Ends the editing of your own thematic word groups without saving the changes you have
made. If you made any changes the Lexicon application will ask you to confirm the 
action. 



Font (menu Edit)
Use the command to change the font, size and typeface in which the text of an entry is 
displayed. After choosing the command the dialog box will appear and you can change the 
font, size, typeface and script. The chosen font style will be used in all windows except for 
the translation window where the application itself select the suitable font style of a 
headword, its elementary translation, or additional notes.    Remember to choose Central 
European script for Czech and other Slavonic dictionaries, otherwise some characters would 
not be displayed correctly.



Options (menu Edit)
The command covers several property pages with options to change the    appearance and 
performance of the Lexicon dictionary according to your needs.

appearance To change the appearance of the application. 
References To change the information displayed in the reference window. 
System To set up another system options. 



Options - appearance
The property page covers options modifying appearance of the Lexicon dictionary. There are 
especially:

Toolbar 
Change the option to display or to hide Toolbar that includes buttons of the most 
frequently used commands of the Lexicon program. 

Navigation bar 
Change the option to display or hide the window with the Result of an inquiry and the 
Reference list, situated in the left part of the Lexicon program window. It contains two 
windows, namely result of an search and references. 

Status bar 
Change the option to display or hide Status baron the bottom border of the Lexicon 
program window. This bar includes more detailed help for    the menu items or for the 
Toolbar. 

Always on top 
Use the command to put the Lexicon application window on the top of the screen even 
when you use other applications that could otherwise cover it. When the option is chosen
the window is put on the top of all other windows; when it is unchecked another 
application is usually placed over it. This option can be useful combined with    the switch 
of Paste all new words from clipboard of the dialog box of Options - System. 

Common combinations of the switches can be quickly set by these buttons:

Default 
Default settings of the Lexicon dictionary. Both boxes and the status bar are on the top, 
the Lexicon dictionary can be covered. 

Minimal 
Minimalized version. The translation window stays alone and besides that the Lexicon 
dictionary is situated in the top right corner of the screen with the option "always on 
top". 



Options - References
On this property page you can set up the information you want to have displayed in the 
bottom left window of the Lexicon dictionary. There are these possibilities:

Synonyms a antonyms 
Words of the same or nearly the same meaning, or of opposite meaning. 

Original topics 
Thematic word groups that form a part of the Lexicon dictionary. 

User topics 
References to the thematic word groups that you have created by yourself in the User 
topics dialog box. 

Morphologically related words 
This option allows displaying of all references shown on the Morphology dialog box. In 
connection with the dictionary there are prefixes, affixes, phrasal verbs or stems. 

Collocations (phrases) 
Through this option you will enable the display of all words containing the current entry 
as a part of a compound word or a phrase. The list can include even several dozens of 
various headwords. 

User collocations 
This option allows displaying of all such collocations, which where added to some user 
dictionary. 

Alphabetical neighbors of the headword 
This option is ordinarily off. After switching it on neighbors of a headword will be 
displayed in alphabetical order on the last tree. 

The last option of Use dialog sheets makes it possible to select displaying of all 
information either in form of a tree (as enabled the previous version) or in a better-ordered 
way of more dialog sheets with trees or lists.



Options - Fulltext
You can use this option only in case that your dictionary supports fulltext search (at present 
the advanced dictionary). Here you can define as needed in which parts of the entry to 
serch. Following possibilities are available: 
Phrases and idioms 

Serching in the entry and all related phrases and idioms (displayed in black boldface) 
Translations 

Serching in terms of translations inside given entry (normal black font) 
Context notes 

Searching in specification notes on the translation line (italics in green) 
Examples and their translations 

Searching among examples and their translations (displayed in boldface italics). 
Explanations and definitions 

Searching in definitions and explanations (displayed in black italics). Definitions are used 
in cases where there is no precise equivalent available or    where it is useful to clarify or 
specify the translation. 

Valence information (displayed normaly in blue italics) is deliberately excluded from    the 
fulltext search since it only contains case prepositions and personal pronouns or 
abbreviations like: sb, sth, j-n., etw. apod.

The last option Display the results in a tree diagram means that the looked up entries 
are collocated according to the options mentioned before. Otherwise    the entries will be 
simply arranged in the alphabetical order.

In case of activation of all the search options    it is more convenient to have also this this 
last option activated. If you limit the search only to one or two options the alphabetical order
might be more practical.

Fro more information about fulltext search see Inquiries about fulltext serch.



Options - System
This property page collects another options usually of greater system nature, e.g. reaction 
on a new text in the Windows clipboard or setting of the language in which the Lexicon 
program communicates with you.

Communication in language 
In this list you can select in what language you want to have all texts of the Lexicon 
dictionary: i.e. menu, dialogs, information of the status bar and also the help. You can 
select English, German. Czech or Slovak. 

Paste all new words from clipboard 
You will use this option in case you want to display or clear the mode of pasting words 
from the clipboard automatically. In case of checking this option the mode is on. In this 
mode the Lexicon program tracks whether a text has not appeared in the clipboard. In 
that case the Lexicon application will paste the text into the input bar and will 
immediately display translation of that entry. If the window of the Lexicon dictionary is 
covered by another applications initialized under the Windows the Lexicon program will 
move over them by itself so that translation of the word could be seen immediately. 
You can find not only translation of one word in this way but even of word groups. You 
can find more detailed information in the command. Paste. 
If you carry over different data than a text through the clipboard, e.g. a picture or sound, 
the Lexicon application will ignore them. 

Pronounce every displayed entry 
You will use this option if you want to switch on or off the mode of automatic 
pronunciation of displayed words. If you authorize the option the Lexicon dictionary will 
play its right pronunciation every time when displaying a new word. 

A new entry will be displayed in following cases:

· after assigning a word in the input bar of the toolbar or in the dialog box of Find
· after pasting a word from the clipboard into the Lexicon dictionary 
· when moving to the previous word of the alphabetical order or the next one 
· when moving in the list of inquiry results or in the synonym list 

See also the command of Pronounce.



User files directory
You can select a folder different from the default setting in this dialog box. If it is located on 
a different drive than displayed, you have to select an appropriate drive in the bottom box 
first. If the selected folder is located in another computer installed in the network, you have 
to map the drive as your logical drive.

If you want to establish a new folder, you have put in its name into the top editing field.



Find (menu Entry)
You will use this command in case you want to change parameters for finding words, e.g. for 
phonetic or morphological search. You can use the command even for usual searching 
words, e.g. when the toolbar is hidden. If the toolbar is on display it is easier to assign words 
right into the first bar of the box.

Through the command, the Find dialog box will be displayed. After putting in a word and 
confirming the dialog the selected word will appear in the toolbar and after looking up the 
headword it will be displayed. 

Abbreviations
Key: CTRL+F



Dialog Find
The dialog box contains mainly the editing field where you put in the word which translation 
you want to find. It is possible to select early inserted word from the history list using the 
down arrow key or the mouse and the button on the right side of the editing field.

In the editing field you can find following items:

Phonetic search 
There is a great difference between the written and spoken form of a word in such 
languages as English. Sometimes it is useful for Czech users to find a word which 
pronunciation is well known but its correct spelling is unknown. If the option for phonetic 
search is checked, the Lexicon will find words even in their spoken form. 

Morphological search 
Sometimes it is necessary to find a word even in a form that varies from its base form. 
Words and word groups inserted from another applications (encyclopedias, helps, web 
pages) are the good example. It is however possible that correct base form is unknown to
users that have English as his or her second language. When the option for 
morphological search is checked, the Lexicon is able to find correctly even such words 
as: went (go), indices (index) etc. 

Automatic language recognition 
When you use a dictionary for translation it is often necessary to find words alternately in
one or the other direction. When the option for Automatic language recognition is 
activated, the Lexicon dictionary can automatically switch over between both languages 
and free you from the need to select a direction of translation. 

Fulltext search 
In case that this option was activated the Lexicon finds simultaneously all the locations 
where the entered words are to be found. The result of searching will be arranged in 
accordance with the part of entry where the word is located    - phrase, translation, 
example, explanation. You can also make a more complicated enquiry viz. Enquiries 
about fulltext search

Some of these options can be limited by the version of dictionary you have purchased, e.g. 
fulltext serch is available only in the advanced version and phonetical search works only in 
the English dictionary.

After confirming the entered word and options the headword will be searched and displayed.



Enquiries about fulltex search
In case of activation of the fulltext search all the locations of the entered word or words will 
be found anywhere in the dictionary. These locations are then highlighted    in the text in a 
different color.

Besides individual words and phrases you can also enter more complicated anquiries like: 

· To look for all the entries where the words "dát" and "pokyn" are located at the same 
time: enter simply dát pokyn or if you wish dát & pokyn

· To look up all the entries where, in terms of one item (i.e. in equivalents for one meaning, 
in the corresponding example or the relevant definition) words "muž" and "žena" are 
located. Enter muž + žena. 

· To look up all the entries where either the word "chlapec" or "hoch"    is located you simply
type: chlapec | hoch. 

· To look for the entries where the word "starý" but not "nový" is located: enter starý - 
nový. 

· To find the entries where the words "základní", "støední" or "vysoká" together with the 
word "škola" are located enter: (základní | støední | vysoká) & škola.

In other words you can construct more complicated enquiries using brackets and following 
operators:

& for logical AND (also possible to use AND) 
| for logical OR (also possible to use OR) 
- for logical axclusion or difference 
+ for logical AND but restricted to only one item of the entry 

In the property sheet Options - fulltext you can limit the fulltex search to specific items only.



Memorizing (menu Edit)
If you want to learn vocabulary of any thematic word groups thoroughly, you will select this 
command.

Through the command the dialog of Memorizing and practicing will be displayed. After 
selecting a topic and possible changing another parameters press the Memorizing button 
or the Practicing button.

If you select Memorize, the Memorizing bar will be displayed in the bottom part of the 
window and you can start memorizing.

If you select Practicing, the Practicing bar will be displayed in the bottom part of the 
window and you can check your knowledge.

Abbreviations
Key: CTRL+U



Dialog of Memorizing and practicing
The dialog includes mainly a list of thematic word groups accessible for the particular 
dictionary. You have the offer of thematic word groups either from the English-Czech (or 
German-Czech) section of the dictionary or from the Czech-English (or Czech-German) one in
connection with the given Direction of translation (compass in the toolbar). The thematic 
word groups are ordered according to subject areas.

The main part of the dialog is covered by the topic list. The thematic word groups are well-
ordered in the tree: first according to the origin dictionary (student's version and an 
advanced one), next according to main thematic groups (e.g. People, Plants, Sport etc.). The 
thematic groups that you established by yourself through the command User topics in the 
Edit menu are located in a separate group.

You can choose the thematic word groups you want to learn or exercise into another list. You 
can select up to ten topics - a larger number is no longer suitable.

Under this list some options for changing useful characteristics of the memorizing or 
practicing modes are shown.

randomly 
When the option is off, headwords are shown in that order they are displayed in the tree 
on the left side of the screen. When it is on, headwords will appear in a random order. 
When the option of Endless loop is on at the same time, the same headword can occur 
after a short moment once more. 

endless loop 
When the option is off, each headword is shown just one time. When the navigation bar 
is on, a reduced word list of a topic is displayed on the left side of the screen until all the 
headwords are expended. When the option is on, the list goes on and on in the either 
successive or random order until you finish memorizing (or practicing) by yourself. 

automatically 
This option is important for the memorizing mode. It is ordinarily on that means that 
headwords are presented automatically in a certain speed. You can select the speed 
through the slider situated in the bottom right part of the dialog. Each headword is 
displayed and the words that have been recorded will possibly play their pronunciation. 
After that a new headword will be shown. When the option is off next headword will be 
shown only after pressing the button Next. 

After pressing the button of Memorizing or Practicing the selected operation will start.



Morphology (menu Entry)
You will use this command in case you do not know the declension or inflection of the given 
word. After selecting this command the morphological forms will appear in a well-ordered 
table. 

Abbreviations
Key: CTRL+T



Pronounce (menu Edit)
This command can be used in case of the student's or advanced dictionaries if there is a 
sound card is installed in your computer. The program will replay the correct pronunciation 
of word recorded by native speakers in CD quality. If you wish the pronunciation to be played
automatically, activate the option of Pronounce all displayed entries on the property 
page System. 

Abbreviations

Button:
Key: CTRL+W



Compare (menu Edit)
You will use this command in case that you want to practice correct pronunciation of a given 
word. You have the possibility to compare your own pronunciation    of a word with the 
original recording by a native speaker in the dialog box of Pronunciation training both 
through listening and graphical figuration.



Dialog Pronunciation training
The dialog includes two boxes: Original record and User record. You can record your own 
pronunciation by means of two middle buttons in the bottom part of the dialog. You can play 
both the original and your own records one after another by means of buttons placed beside 
the graphical figuration of both recordings.



Back (menu Edit)
You will use this command if you need to come back to a word assigned or browsed before.

The Lexicon program can remember all the words assigned to be found either directly 
through the keyboard, transmitting through the clipboard or clicking some word translation. 
That is further possible with shown synonyms or other words being a result of an inquiry.

You can go back by 32 steps in this way. 

Abbreviations

Button:
Key: ALT + left arrow

See also the command Forward.



Forward (menu Entry)
You will use this command when you have came back to a headword through the command 
of Back and now you want to "move" to another headword (i.e. which was assigned later 
than the newly displayed word). 

Abbreviations

Button:
Key: ALT + right arrow



Previous (menu Edit)
You will use this command if you want to display the word alphabetically previous to the 
currently shown one. Be mindful that there are different conventions for sorting words and 
phrases in different languages. The Lexicon dictionaries respect it. 

Abbreviations

Button:



Next (menu Edit)
You will use this command if you want to display the word following the currently shown one.
You should bear in mind that there are different conventions for sorting words and phrases in
different languages. The Lexicon dictionaries respect it. 

Abbreviations

Button:



Topics
Using this command you can display contents of the help.



About (menu Help)
You will use this command if you want to acquire information about the developer, year of 
the product development or its version number.



Find box
You will enter a word you want to be translated into this dialog box and press the Enter key 
next. The Lexicon will find the relevant headword or headwords, all of them will be inserted 
into the Result of an inquiry window and the translations of the first headword will be shown 
in the translation window.



Change of the translation direction
This first button in the toolbar located next to the find box will inform you about the 
translation direction.

If automatic language recognition option is enabled in the dialog box Find, the Lexicon 
dictionary can switch the button as needed and has a rather informative character. In case 
that this option is denied, or you need to change direction manually, press the button 

Abbreviations

Button:



Toolbar
The toolbar is displayed on the top window margin, right bellow the menu. It serves to 
display the name of the most frequently used commands of the Lexicon program in a 
simplified form. You can only move the cursor on the selected    button and press the left 
mouse button, and the command will be executed immediately.

If you are not sure which command the button represents, it is sufficient to move the mouse 
cursor on the proper button. A more detailed command description will appear in the status 
bar. At the same time, a brief help in the form of a yellow box will be displayed bellow the 
button.

If you want to hide or to show the toolbar use the switch of toolbarin the dialog box of 
appearance.

Press if you wish to 
change the translation direction. 
move to the previously displayed headword. 
move to the next displayed headword. 
move to the previous headword in the alphabetical order. 
move to the next headword in the alphabetical order. 



Memorizing bar
This bar will be automatically displayed by pressing the button of Memorizing in the 
Memorizing and practicing dialog. Particular buttons of the bar enable you to suspend and 
restore, stop or restart replaying of vocabulary.

Press if you wish to 
move to the next headword in the non-automatic mode. 
restart replaying of vocabulary. 
suspend automatic replaying or to restore it again. 
stop replaying of vocabulary (the word list will be restored in its 
original appearance). 
quit the memorizing mode. 



Practicing bar
This bar will be displayed automatically by pressing the button of Practicing in the 
Memorizing and practicing dialog box. The first field of the bar serves for inserting your 
guess for the correct translation. Other buttons can be used to skip an already familiar or 
unknown word or to display the correct equivalent.

Press If you wish to 
skip the word that is really familiar to you. 
skip the word that you unfortunately do not know. 
display the correct translations. Then press one of the two 
previous buttons. 
quit the practicing mode. 



Result of inquiry
This box is displayed in the left part of Lexicon program window and contains a list of entries
searched on the basis of your inquiry.

In case that you have assigned a word group (more than one continuous word), the words of 
the list are displayed in the same order as assigned.

In case that more entries were found for a given inquiry all of them will be displayed in the 
list. 
For more detailed information see Word found.

In case that no suitable entry was found a list of similar or    related words will be displayed. 
For more detailed information see Word not found.



Word found
In certain cases it is possible to obtain more entries as a result of one inquiry. It depends on 
the current setting of parameters in the option dialog. Find.

It includes mostly these cases: 
· The assigned word is derived from two different stems, e.g. the word ženu is a form both 

of the noun žena and also of the verb hnát. But only in case that the Morphological 
search is on. 

· The assigned word can be a phonetic transcription of some other headword as well, e.g. 
in the English dictionary, entries sin, sing, thin and thingwill be displayed after assigning 
sin. But only in case Phonetic search is on. 

· The assigned word exists in both languages - for example words list or mostcan be found 
in both Czech and English. In such case the word from the opposite language is marked 
by a swung dash in the list. This happens only in case that, automatic language 
recognition is on. 

· There are morphologically related words the translation of which might be interesting for 
the user. For example entries nepìkný and pìkný for the headword nepìkný, or entries 
ostøe and ostrý will be displayed after assigning the word ostøe, or in the case of English 
both words would and will for would. 

· If you have bought more dictionaries for the given language, the Lexicon program 
searches automatically all of them. Entries from different dictionaries are distinguished by
diverse icons to make the list more transparent. For instance: for the student's dictionary 
the icon of an open book, for the advanced dictionary - temple, business German - three-
dimensional chart etc. 

If the very general (i.e. phonetic, morphological, bi-directional) search is set, the list can 
contain any combination of the possibilities mentioned before. That is, however, no problem 
as it is easy to select the matching word. Moreover it can serve the user to unveil interesting
connections leading to deeper penetration into a foreign language.



Word not found
If a word was not found in the dictionary, the cause can be a simple misspelling when 
assigning word or the simple fact that the particular word does not exist in any of currently 
available dictionaries. Lexicon aims to offer assistance in both of these cases. It offers the 
user a list of words existing in the dictionary and besides:

· differing from the assigned word in an altered, redundant    or missing letter or containing 
a modified order of typed letters, 

· having the same initial part as the assigned word. 

Words belonging to the first group are labeled as Misspelling, words belonging to the other 
group as Neighbors.

The fact that the Lexicon dictionary offers a list of similar words can be utilized    when 
inserting a word into the inquiry. It is sufficient to insert just a few initial letters, and the 
Lexicon dictionary will display all the "related" words.



Reference list
A list of words related in some way to the current entry will be displayed in the bottom left 
part of the screen. According to the kind of relation the words are assorted into several 
groups and arranged into a tree. Smaller groups are unfolded immediately, the larger ones 
can be displayed by unfolding the corresponding branch of the tree.

Synonyms 
are words of the same or nearly the same meaning. e.g. clever, apt, bright, smart etc. 

Antonyms 
Are words of the opposite meaning. e.g. clever vs. stupid. 

Topics 
Further a name of a relevant thematic word group or groups can appear together with 
the displayed headword. Each of these thematic groups gathers words related to certain 
topic by it's meaning. For example: Family, Birds, Foliate trees, Colors etc. 

Prefixes 
includes words that differ from the current entry by it's prefix. The extent of this group 
depends on the current language and dictionary. 

Derivative 
includes words that differ from the current entry by it's suffix. The extent of this group 
depends on the current language and dictionary. 

Stems 
This group contains all the words that formed the given word. For instance: for the 
German Fachoberschule: Fach, Ober, Schule, but also Oberschule. 

Phrasal verbs 
In English lots of verbs combined with prepositions or adverbs form phrases that have 
quite a different meaning compared to the original word. They are called phrasal verbs 
and constitute a very important part of the English language. Therefore these words are 
displayed in a separate subsection. 

Collocations 
This group offers a list of words or compound words containing the current entry as it's 
part. For example for the English put: put-down, put-on, shot put etc. 

Neighbors 
are words before or after the given word in the alphabetical order. Displaying of these    
words is switched off in the standard mode. 

Displaying of individual groups can be set in the dialog of References.

This tree is an excellent didactic tool showing in a natural form many relations among 
individual entries.

If you click with the left mouse button on a word in any of these two lists, you acquire an 
immediate display of its proper translation. It is also possible to scroll the list by means of 
arrow buttons and the Lexicon program displays continuously appropriate translations.



Translations
The elementary window of the Lexicon application. Translations of a current entry together    
with additional information serving for better comprehension are displayed in it. Translations 
are sectioned into semantic lines arranged according to the frequency of use or etymology.

The entry usually contains following items:

Entry 
is displayed on top in blue color and in larger letters. 

Other possible spellings 
are displayed immediately behind the headword in minor letters and darker color. 
Geographical or historical classification of the word form is displayed in brackets, e.g. 
AmE for American English. 

Pronunciation 
is displayed in square brackets and red color right behind the entry. International 
Phonetic Alphabet was used for its transcription. If you click with the mouse on this 
transcription the Lexicon will replay the correct pronunciation. 

Class of words 
is displayed either immediately behind the entry (behind its pronunciation) or    in the 
beginning of the translation group corresponding with one given class of words. Survey 
of class of words abbreviations

Translations 
are displayed in the basic black color. If you click on any displayed translation with the 
left mouse button, the translation is set off in contrast color and can be pasted into the 
clipboard etc. If you click on the word with the right mouse button, a small menu of 
options will be displayed. If you double-click with the left mouse button the reverse 
translation will be looked up. 
Font size and font type can be set through the command Font in the menu Edit. 

Meaning specification 
is put down before or behind the appropriate translation (depending on the direction of 
translating) in italics and green color. 

Valence information 
are put down behind the relevant verb or other word in italics and blue color. 

Examples 
In some cases it is desirable to append an example to the translation or explanation. 
Examples are always put down to a fresh line and in different font. 

Morphological notes 
In special cases the word meaning is supplemented by a specifying comment displayed    
in minor characters and red color. 



Class of words abbreviations
Following abbreviations are used to mark individual word classes:

N for nouns 
Adj for adjectives 
Pron for pronouns 
Num for numerals 
V for verbs 
Adv for adverbs 
Prep for prepositions 
Conj for conjunctions 
Part for particles 
Intr for interjections 



Status bar
The status bar is displayed on the bottom border of the Lexicon program window. If you wish
to display or hide it again, use the option of Status bar in the dialog of Options - 
Appearance.

The left part of the status bar specifies the commands that are to be executed after 
selecting the given menu item or the button in the status bar that the cursor is placed on.

The right part of the status bar describes switching of Caps Lock, Num Lock a Scroll Lock 
keys.



Title
The title is called the top border of window where the selected language and file name are 
located. In the left corner of the title, there is the so called system menu. The right corner 
contains buttons for minimization and maximization of the window and for quitting the 
program.



Scrollbars
In case that the entry does not fit entirely into the Translation window, a scrollbar is 
displayed on the right border of the window showing how big proportion of the entry is being
displayed currently. It is also possible to scroll the entry by means of scroll arrows and see 
the whole text.



Lingea Ltd
Lingea Ltd is a company developing and marketing supreme quality electronic dictionaries 
and other language tools like spell-checkers, dictionaries of synonyms    for many European 
languages.

Address: 
Lingea Ltd. 
Husova 8a 602 00 Brno Czech Republic 

Contact: 
tel,fax: ++420-5-43235026 
web: www.lingea.cz 
e-mail: info@lingea.cz

On our web pages you can find: 
- product information 
- free demo versions 
- list of resellers 
- technical support




